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Ve ‘? Case 1: Your Mission

a9
el ﬁ;—" Parts A, B and C
' . Goal: Introduce Students to the Project and to the Concepts of
Team Work by Forming a Detective Agency and
Registering With Headquarters
Objectives: > Introduce the Project
> Model an Effective Team Meeting
> Share Team Work Strategies
> Choose a Name for Your Detective Agency
> Introduce Students to the Web Site
> Register Your Detective Agency Online
Time Required: 2 After-School Sessions
Day 1 - Parts A & B
Materials Required Learning Standards Addressed
Message from Headquarters (CD), Language Arts:
Chalk Board Goals3 A, 4Aand4B
Math:
Student Handout Goals 6 B and C

Your Mission
Applied Learning Standards Addressed
Assessment Tool Communicating, Using Technology
Participation Rubric and Working on Teams

Vocabulary Words
Icebreaker: (noun) Technique for introducing people to each other

Brainstorm: (noun) Group discussion to produce ideas

Copyright © EnergyNet Page 1



Part A - Introduce the Project

Step 1: Play the CD Message from Headquarters

A CD containing Message from Headquarters has been included with
your teaching materials. This is a short (3 slides) narrated PowerPoint
for your students.

The message on this CD explains to your class that energy is being
wasted at your school. This costs the school money that could be spent on education, it
hurts the environment and it can make the building occupants uncomfortable. CPS has
chosen them to help solve this problem which is being called The Great Energy Caper.

Step 2: Distribute the Student Handout: Your Mission

After you've played the CD, distribute the Student Handout entitled Your
Mission. Let your students know that to solve The Great Energy Caper they
will establish a Detective Agency and work as a team to complete several
energy cases. To help them, Headquarters has assigned Special Agent FIiP
the Switch to work with them over the Internet.

Also, within your school, some of the older students will be forming a
team of Energy Coaches. The Coaches will also help the Detectives solve The
Great Energy Caper.

Step 3: Icebreaker Exercise

In order to operate as a team, your students will first need
to cooperate and communicate with each other. To make
that easier, you will want to conduct an Icebreaker. Tell
them that you want them to begin thinking of themselves as Detectives. To do that, ask
them to sit in a circle.

Once in the circle, ask them to introduce themselves to each other by their first name
followed by a detective-related word beginning with the first letter of their first name (ie.
Ann Alibi).

Step 4: Discussion
Sitting in the same circle, ask for 2 volunteers to write

notes on the board while you lead a discussion with Taking Notes
the class. Use headings

Only write the key words

Lead a discussion with the class about teams. Point

out to them that a good discussion has some ground Ask the group to be respectful
rules such as: of the note taker’s need to

complete their task.

No Interrupting

Be Respectful of Each Other
Listen to Understand
Everyone Participates

LK
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Participation Rubric

Listening and Asking Questions for Clarification

Student Name:

Listen attentively by facing the speaker and making eye contact. x4 =
1 2 3 4 5

Poor Excellent

Demonstrate ways that listening attentively can improve comprehension such X 4=

as asking probing questions, providing feedback to the speaker, summarizing
and paraphrasing complex spoken messages.

1 2 3 4 5

Poor Excellent

Ask questions and respond to questions to improve comprehension. x4 =
1 2 3 4 5

Poor Excellent

Use good grammar and manners when asking or responding to questions. X4 =
1 2 3 4 5

Poor Excellent

Apply listening skills such as note taking, waiting to ask questions until

timing is appropriate, not asking a question which has already been asked and x4 =
answered.

1 2 3 4 5 Total Score
Poor Excellent

Copyright © EnergyNet Page 4



Headquarters would like you to help solve The Great Energy Caper.
This is an important job so Headquarters has assigned

Special Agent FliP the Switch to help you.

Together with your school’s Energy Coaches, your mission
is to catch and help reform 5 groups of Energy Suspects:

Behavior Burglars
Leaky Looters
Evil Equipment
Lighting Larceny
Air Abductors

The Behavior Burglars are known to waste energy by leaving things on
when they’re not needed. Examples include lights, televisions, appliances
and water. The Behavior Burglars may not realize the damage they’re doing.
It will be your job to track these Energy Suspects and teach them to FIiP the
Switch.

The Leaky Looters wastes energy by stealing the comfortable air from
inside a building and forcing that air outside. This makes the furnace or air
conditioners work harder and longer which costs extra money. The only way
to stop the Leaky Looters is to find the places where they sneak in and plug
the leaks. It will be your job to find those places.

The last three suspects: Evil Equipment, Lighting Larceny and Air
Abductors are groups of con men that steal energy by convincing people to
buy energy wasting products like incandescent lights and non-Energy Star
rated appliances and equipment.

Good luck Detectives - We're counting on you!

Copyright © EnergyNet Page 5



Day 2 - Part C: Register Your Detective Agency

Materials Required Learning Standards Addressed
Computers with Internet Access, Language Arts:
Detective Identification Cards, Goals 1 Aand B; 3 A and B;
Pencils, Scavenger Hunt Form 4Aand5A

Student Handout Applied Learning Standards Addressed
Scavenger Hunt Communicating, Using Technology

and Working on Teams
Evaluation Tool
Participation Rubric

Step 1: Get Online

Establish Partners

Divide your class into teams of two before you head for the computers. Determine which
student will be at the keyboard for the first half of the lesson and which student will be at
the keyboard for the second half. Make sure each student has a pencil, knows who their
partner is and knows what computer they should use.

Once students are seated at the computers, distribute a Detective Identification Card to
each student.

Log On

Each team will be asked to log on to the project home page at www.Energy-Detectives.net.
Before you give them the URL, ask the student who is not at the keyboard to raise their
hand. They should keep their hand raised until their partner has successfully logged on to
the home page. This will let you know if a team is having problems without the need for
students to yell.

Each student will have their own user name and password. This will allow them to use the
journal. Ask each student to post a message on the journal or to respond to their Secret
Agent’s Welcome message.

Step 2: Scavenger Hunt

A scavenger hunt has been developed to familiarize your students with the web site.
Working in their teams of two, distribute one sheet to each team. One student will work the
mouse while the other student will fill in the answers. After approximately 5 minutes, ask
the team to switch roles.
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Scavenger Hunt

Answer Key

Begin at the project home page <http://www.Energy-Detectives.net>.

1. Let's Play a Game!
v Click on the EnergyNet Community Web link under Additional Sources.
v Click on the Games link on the left navigation bar.
What is the name of the first Energy Game? Energy Memory Game
2. Leave the EnergyNet Community Web

v Click on the X in the upper right hand corner.

Where are you now? Back at the CPS Energy Project
Web Site
3. Let’s Explore the Project Home Page!
How many areas do you see? Three
4, What Are The Names of Each Area? Buildings, Energy Data and
Journals
5. Let's Check Out the Journal!
This is where you can send and get messages.
v Find the message called “Scavenger Hunt.”
What does the message tell you? October is National Energy Month

Copyright © EnergyNet Page 7



Scavenger Hunt

Name

Begin at the project home page <http://www.Energy-Detectives.net>.

1. Let's Play a Game!
v Click on the EnergyNet Community Web link under Additional Sources.
v Click on the Games link on the left navigation bar.

What is the name of the
first Energy Game?

2. Leave the EnergyNet Community Web
v Click on the X in the upper right
hand corner.

Where are you now?

3. Let’s Explore the Project Home Page!

How many areas do you see?

4, What Are The Names of Each Area?

5. Let’s Check Out the Journal!
This is where you can send
and get messages.

v Find the message called
“Scavenger Hunt.”

What does the message tell you?
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Online Password

Detective Identification Card
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~—~,Case 2: Energy: The First “E”
- Parts A and B

Goal: Demonstrate the Basics of Energy Conservation While Allowing
Students to Discover How Much They Actually Know About the
Subject

Objectives: > Compare Energy Conservation Opportunities for

Schools to the Techniques Humans Use to Control
Their Own Thermal Comfort

> Identify Opportunities for Energy Conservation
u Insulation
] Sealing Air Leaks
] Efficient Use of Natural and Artificial Light

> Present Data that Prioritizes Energy Efficiency
Techniques

> Increase Students’ Comfort Level With the Material
by Engaging Them in a Fun Activity

2 After-School Sessions

Day 1 -Part A

Time Required:

Materials Required

Hat, Coat, Draft Detector’, Ear
Muffs, Scarf, Sunglasses and Our
School is Energy Efficient Handout

Student Handout
Our School is Energy Efficient
Help Energy Ed Get Ready for
Winter

Assessment Tools

Learning Standards Addressed
Language Arts:
Goals 1 A, Band C;

4Aand5A
Math: Goal 6 A
Science: Goals 12 C, 13 B

Applied Learning Standards Addressed
Solving Problems, Communicating,
Working on Teams and Making
Connections

Our School is Energy Efficient
Help Energy Ed Get Ready for
Winter

! A simple draft detector can be built by clipping a
piece of tissue paper or plastic wrapping to a coat

hanger. Hold the coat hanger in front of a suspected
leak; any movement of the paper will indicate air
leakage.

Copyright © Educational Dividends
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Vocabulary Words
Insulate:(verb) Cover with non-conducting material to prevent the passage of
conditioned air

Cellulose: (noun) A material created from fiber such as paper or cotton
Caulk: (noun) A waterproof filler and sealant

Weatherstrip: (noun) Metal, plastic or felt strips designed to seal spaces between
windows and door frames

Procedure

Use a volunteer who will be the school building. The building will be retrofitted to show the
basics of energy conservation. Review your points by removing the retrofits from your
volunteer school building in reverse order. Then, distribute the handout.

Step 1: Choose a Volunteer
Explain that you will be discussing the basics of energy conservation in schools. Ask how
many of the students feel comfortable that they know the basics and how many don't.

Then, request a volunteer to serve as the school building to illustrate the principles of
energy conservation. Welcome the school building and thank the student for volunteering.

Step 2: Weatherize the School Building

The following information should be presented in order. Once the class has identified an
energy conservation technique, select a student to install the technique. Be careful that the
students don't get so excited that they mistreat the school building.

Copyright © Educational Dividends
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Building Envelope

Teacher’s Script

Additional Information

1. [Teacher]

Our school building seems to be losing
its heat. What do you think would be
the first thing we can do to keep
heated - or cooled - air from leaving
the building?

Technique #1: Insulation
(Cellulose does the best job in walls
and ceilings)

[Answer] Facts:
Insulate. Yes, first you insulate your ceiling | » Insulating reduces energy costs by
or attic and then your walls. 20-30%
[Action] > Heating is 75-95% of a school’s
Would someone come up and show us natural gas expense
how to insulate our school building?
> Cooling is 10-15% of a school’s
> Put the hat on first electric energy expense
> Then the coat
[Teacher] Technique #2: Caulk and Weatherstrip

There are a number of things we can
do to reduce our energy use, save
money and be more comfortable. One
way is to reduce drafts. Let’s see if our
school building has any drafts.

> Place draft detector in front of the
school building’s face and ask them
to blow.

Oh my yes, we seem to have a drafty
building. What can we do to seal the
drafts?

[Answer]

Caulk around windows and any openings
like window air conditioners, electric
outlets, plumbing and wiring. Weatherstrip
around doors.

[Action]
May I have a volunteer to help seal our
building’s air leaks?

> Put a scarf over the mouth

> Then hand them some ear muffs
saying you think you heard some air
escaping there as well

Note:

> You can also save money by
properly maintaining your heating
equipment. Make sure it's tuned up
regularly and clean filters once a
month.

Copyright © Educational Dividends
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Lighting

Teacher’s Script

Additional Information

[Teacher]
How can we reduce the energy our
building uses for lighting?

[Answers]

> Use the lights wisely; turn off lights
when not in use

> Open drapes in the winter for light
and heat

> Close drapes in the summer for
cooling

> Switch to energy efficient lights

> Plant trees for shade

[Teacher]

Who would volunteer to help shade the
school building?
> Put sunglasses on your building

Facts:

> 65-80% of the school’s electric
energy is used for lighting, cooking
and running equipment

> T-8 fluorescent with electronic
ballasts are best for classroom use

Step 3: Review

Teacher’s Script

Additional Information

[Teacher]

Congratulate the students on how
much they already know about energy
efficiency. Then review what was
learned by removing the items on the
building in reverse order:

> Sunglasses
> Ear Muffs
> Scarf

> Coat

> Hat

> Shading the school with trees and
using our blinds can save energy

> Drafts make us uncomfortable and
waste energy. Remember to caulk
windows and weatherstrip doors

> Insulation keeps cooled and heated
air in our building. Ask the
building: “Are you warm?”

Copyright © Educational Dividends
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Step 4: Assessment

Assessments are offered for
three age groups:

1) Using the worksheet Help Energy Ed Get
Ready For Winter, ask your students to
identify the top three ways to reduce air
infiltration (drafts). Students will be asked
to color the items of Energy Ed’s clothing
that corresponds to:

> Attic Insulation
> Wall Insulation
> Weatherstripping

Grades 3-5

2) Using the worksheet Our School is
Energy Efficient, ask your students to
complete the sentences to identify actions
that will reduce energy use. You may
choose to provide younger students with a
list of the correct vocabulary words for this
exercise. The correct actions are:

Heated and cooled air can’t escape because
we insulated attics and walls.

We keep the doors shut and stop drafts by
weatherstripping.

At night we close the shades.

Trees are great! Their shade keeps the
school cool in the Spring and Summer and
blocks the cold wind in the Winter.

In the Spring we open the windows to be
cool. In the Winter we stop drafts by

caulking.

When it is sunny we open the blinds and
turn off the lights.

Grades 6-8

Copyright © Educational Dividends
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Day 2 - Part B
Day 2 - Part B

Materials Required Learning Standards Addressed
Guest Speaker on Demand CD: Language Arts:
Match Schtick the Magnificent Goals 1 A, Band C;

4Aand5A
Math: Goal 6 A

Additional Teacher Resources: Science: Goals 12 C, 13 B
Issues, Evidence and You C1.:
Investigating Energy Transfer, C7: Applied Learning Standards Addressed
Electrical Energy: Sources and Solving Problems, Communicating,
Transmission, C9: Energy from the Working on Teams and Making
Sun Connections

Vocabulary Words
Potential Energy: (noun) Energy that is ready to be released

Kinetic Energy: (noun) Energy that is already in motion

Renewable: (adjective) Can be replaced, renewed in a short time
Non-Renewable: (adjective) Can not be replaced, took millions of years to create
HydroElectricity: (noun) Electricity generated using moving water

Biomass: (noun) Waste from plants and animals

Geothermal: (adjective) Energy produced by the internal heat of the earth

Hydrogen: (noun) A colorless, odorless, highly flammable gas; the lightest of the
chemical elements

Uranium: (noun) A gray dense radioactive metallic chemical element; used as a fuel
in nuclear reactor

Copyright © Educational Dividends
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Step 1: Play the CD Match Schtick the Magnificent
A CD containing Match Schtick the Magnificent has been included with
your teaching materials. This is a narrated PowerPoint describing the

Step 2: Suggest that the Students Take Notes
Before you play the CD, suggest that the Detectives may want to make notes as they listen.

Step 3: Discussion

Ask the students if they have any questions about the information on the CD. You may

choose to ask some leading questions to be sure they understood. Questions might include:
So what energy sources can we use to make electricity?

What energy sources are renewable? What does that mean?

Copyright © Educational Dividends
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v *? Case 3:Economics

The Second “"E”

Introduce Students to Graphing Using Real Data

[ and Provide Them With Information on How Much
y a School Spends on Energy

Objectives:

Introduce Students to the Use and Creation of Bar Graphs

Provide Students with Information on the Cost of Energy
> Visually Demonstrate the Relationship Between Weather

and Energy Use

Time Required:

Materials Required
School’s Utility Costs and Use from
the Previous School Year,
Definitions of Data and Bar Graph,
Example of a Bar Graph,
Data Collection Forms, Rulers or
Straight Edge, Colored Pencils

Student Handouts
Data Collection Forms (7)

Assessment Tool
Completed Data Collection Forms

Vocabulary Words

1 After-School Session

Learning Standards Addressed
Language Arts:
Goals 1 A, Band C;

4 Aand 5A
Math: Goal 6 A
Science: Goals 12 Cand 13 B

Applied Learning Standards Addressed
Solving Problems, Communicating,
Working on Teams and Making
Connections

Additional Teacher Resource:
http://www.math.com/teachers.html

Bar Graph: (noun) A way to show information that uses bars to stand for data

Kilowatt: (noun) A unit of electricity equal to 1,000 watts

Kilowatt Hours: (noun) A unit of electricity equal to one kilowatt for one hour

Therm: (noun) A unit of gas fuel equal to 100,000 Btus

Copyright © EnergyNet
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Prior to Class

You will need to obtain your school’s utility data for the past school year. To do this, simply
go to the Energy Data section of the project web site (www.Energy-Detectives.net). You will
need the following data for each of the 12 months of the previous school year:

1. Total units of energy used and the related costs on
a monthly basis
You will be looking for:
Electricity= kWh
Natural Gas=Therms

2. Total cost for each fuel source on a
monthly basis
Data collection forms for both electricity
and natural gas are provided for your
use

Bar Graph: A way to show
information that uses
bars to stand for data

Data: Information collected
about people or things

Step 1: Introduce Lesson

Begin by explaining that, in order to solve the
Great Energy Caper, the detectives will need to know how much energy is being used and
for what purposes. Let them know that you have obtained copies of the school’s utility bills
for the previous school year.

Step 2: Explain a Bar Graph

Explain a bar graph and its uses. If this is a new concept to your students you may choose
to show them some simple examples. If you are working with older students who are
comfortable with bar graphs, you might ask them to complete the next exercise using the
computer.

Step 3: Explain the Exercise

Explain to the students that they will be working in teams to accurately graph the amount of
energy used by type and the cost for that energy during the last school year by month. You
will provide the data and they will be expected to create the bar graphs.

Step 4: Small Group Work
Divide the class into four groups. Provide each group a data collection form, rulers or
straight edge, colored pencils and the appropriate blank bar graph form.

Each team’s first task will be to determine the amounts to put in the left column of the
graph. If you have younger students, you might choose to complete this for them.

Each team should complete their graph. After completing the graph they should answer the
questions and present their findings to the rest of the class.

Copyright © EnergyNet Page 20



Data Collection Form
Electricity

In a school, electricity provides power to lights and equipment
like computers, fans and televisions. Electricity can also provide
power to air conditioners and heaters.

Month

kWh Used Cost for Electricity

August

September

October

November

December

January

February

March

April

May

June

July

TOTAL
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Data Collection Form
Natural Gas

In your school, the heating of air and water is provided by
natural gas. Natural gas is measured in therms.

Month Therms Used Cost for Natural Gas

August

September

October

November

December

January

February

March

April

May

June

July

TOTAL

Copyright © EnergyNet Page 22



Data Collection Form - General

School Name:

Date School Was Built:

Total Square Footage of School:

Total Occupants (Teachers, students and staff):

Copyright © EnergyNet Page 23



Graph of Electricity Use
In a school, electricity provides power to lights and equipment like computers, fans

and televisions. Electricity can also provide power to air conditioners and heaters.

Use by
kwWh

August September October November December January February March April May June July
What months had the highest use?

Why?
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Graph of Electricity Cost
In a school, electricity provides power to lights and equipment like computers, fans
and televisions. Electricity can also provide power to air conditioners and heaters.

Cost in

$$ per
Month

August September October November December January February March April May June July
What months had the highest costs? Why?

What was the total cost for electricity for the last school year?
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Graph of Use of Natural Gas
In your school, the heating of air and water is provided by natural gas. Natural gas is measured in therms.

Use by
Therms

August September October November December January February March April May June July
What months had the highest use?
Why?
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Graph of Cost of Natural Gas
In your school, the heating of air and water is provided by natural gas. Natural gas
is measured in therms.

Cost in
$$ per
Month
August September October November December January February March April May June July
What months had the highest costs? Why?

What was the total cost for natural gas/propane/other for the last school year?
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e *? Case 4:Environment - The Third "E”
1?3” L
e ’ Goal: Students Will Use the Internet as a Tool to

Discover Information on the Environmental Impact
of Energy

Objectives: > Provide Students with Practice Visiting Internet
Sites
> Provide a Sampling of Energy and Environmental
Sites
> Introduce the Impact of Energy Use on the
Environment

Time Required: 1 After-School Session

Materials Required Learning Standards Addressed
Internet Access, Scavenger Hunt Language Arts:
Form for Each Team and Writing Goals 1 A, Band C;
Instruments 4Aand5A

Student Handouts Applied Learning Standards Addressed
Scavenger Hunt Form Communicating, Using Technology,

Assessment Tool Working on Teams and Making
Completed Scavenger Hunt Form Connections

Additional Teacher Resource:
Web Sites Listed in Scavenger Hunt

Vocabulary Words
Renewable: (adjective) Can be replaced, renewed in a short time
Non-Renewable: (adjective) Can not be replaced, took millions of years to create

Incandescent: (adjective) Containing a filament which glows white-hot when heated
by an electric current

Fluorescent: (adjective) Based on fluorescence from a substance lit by ultraviolet
light (Notice the unique spelling fl UO rescent)

Recycle: (verb) Convert waste into reusable material

Copyright © EnergyNet Page 28



Step 1: Introduce the Lesson

Explain that students will be working in teams of two to complete the Online Environmental
Scavenger Hunt. The purpose of this activity is to point out how energy use has an impact
on the environment. Throughout the activity, students will be directed to visit various web
sites.

Step 2: Establish Partners

Divide your class into teams of two before you head for the computer lab. Determine which
student will be at the keyboard for the first six questions and which will be at the keyboard
for the last four questions. Make sure each student has a pencil, knows who their partner is
and knows what computer they should use. The student who is not at the keyboard should

raise their hand if they have technical difficulty.

Once in the lab and the students are seated at the computers, distribute the Scavenger
Hunt form.

Step 3: Complete the Form

As soon as a team has their form, they may begin. They should switch places at the end of
five correct questions. When their form is completed, the team should put their name on
their form and turn it in.

Step 4: Review
Review the correct answers with your students and ask your students some leading
questions such as:

What new information did they learn and what did they already know?

What information surprised them?
What actions will they take as a result of what they learned?

Copyright 1999 © EnergyNet Page 29



Environmental Scavenger Hunt

Detectives:
Your first set of clues
are at = http://www.energynet.net/detectives/hunt.htm

1. What is the single most effective action you can take to help the
environment?

2. Circle the type of energy source that can cause pollution
Renewable
Non-Renewable
Both

3. Circle all of the energy sources that are renewable
Natural Gas
Solar
Coal

Detectives:
Your next set of clues

'-,. are at = http://www.ase.org/content/news/detail/2336

4. If everyone in America replaced four 100 watt incandescent light
bulbs with compact fluorescent bulbs, we’d save as much energy
as produced by how many power plants annually?

5. Click on the Hog. Who is he and what does he do?
6. Review the Handbook to learn about saving energy in your home.
To save water, limit your showers to minutes.

It's time to switch roles. If you were operating the computer, you will now be
reading the questions and writing in the answers.
Of course, both of you will be working together to find the answer!
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Detectives:
Your next clue can
be found at =

http://www.epa.gov/epaoswer/osw/kids/games/index.htm

6. Visit the EPA’s Raw Materials Lineup to learn that plastic toys
are made from this non-renewable energy source:

Detectives:
Your final clues
can be found at = http://www.epa.gov/recyclecity

7. Go to Recycle City and visit the Southwest section of town. This
is where the school is. Ms. Redux’ class is learning about the 3
R’s. What are the 3 R’s:

8. Give two examples of the first R:

9. Give two examples of the second R.

Congratulations! You have completed the Scavenger Hunt.
Please write your names on the lines below and then turn your completed
Scavenger Hunt form into your teacher.

Name:

Name:
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Environmental Scavenger Hunt
Answer Key

Clue: http://www.energynet.net/detectives/hunt.html
1. What is the single most effective action you can take to help the environment?
Use Energy Wisely

2. Circle the type of energy source that can cause pollution (answer in bold)
Renewable
Non-Renewable
Both

3. Circle all of the energy sources that are renewable (answer in bold)
Natural Gas
Solar
Coal

Clue: http://www.ase.org/content/news/detail/2336

4, If everyone in America replaced four 100 watt incandescent light bulbs with compact
fluorescent bulbs, we'd save as much energy as produced by 30 power plants
annually.

5. Click on the Hog. Who is he and what does he do? Sucks the energy out of the
home

6. Review the Handbook to learn about saving energy in your home. To save water,

limit your showers to 5 minutes.

Clue: http://www.epa.gov/epaoswer/osw/kids/games/index.htm
6. Visit the EPA’s Raw Materials Lineup to learn that plastic toys are made from this
non-renewable energy source: oil
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Clue: http://www.epa.gov/recyclecity

7. Go to Recycle City and visit the Southwest section of town. This is where the school
is. Ms. Redux’ class is learning about the 3 R’s.
What are the 3 R’s: Reduce, Reuse, Recycle

8. Give two examples of the first R. Purchasing goods that use less packaging,
sharing or renting things (like carpet cleaners) that aren't needed regularly
instead of buying them, and buying household cleansers that do not contain
hazardous ingredients.

9. Give two examples of the second R. Using glass or plastic jars after
they're empty, or taking a cloth sack to the store when you shop (you don't
need a bag, and you can use the sack again the next time).

Here at the school, many of the kids bring their lunches in plastic containers,
which they can wash and use over and over again, instead of wrapping their
food in plastic and paper that they throw away every day. Meanwhile, some
businesses have donated their old computers to the school for reuse, and the
local theatre company donates its used sets and costumes to the Drama
Club.

Copyright 1999 © EnergyNet Page 33



i 0 ;
¥ i

I . .
~ .9 _ Case 5: All Points Bulletin
ey S

P oal: Allow Students to Use Real Data to Explore the
! Concept of Numerical Comparisons

Objectives: » Introduce Students to the Concepts of
Numerical Comparisons
> Allow Students to Better Understand the
Meaning of Their School’s Energy Use and
Cost Data
Time Required: 1 After-School Session
Materials Required Learning Standards Addressed
Copies of the Completed Bar Language Arts:
Graphs From Case 3 Goals4 Aand B
Math:
Student Handouts Goals 8 B, 10 Aand C
None
Applied Learning Standards Addressed
Communicating and Making
Connections
Procedure

The Coaches will meet with the Detectives to present your school’s energy use and cost
data. They will also compare your school’s energy use and costs to the other Chicago Public
Schools participating in the EnergyNet After-School Program.

Step 1: Introduce Activity

Explain that your school’s Energy Coaches will be making a presentation about your school’s
energy use and costs. Also let the Detectives know that at the conclusion of the Coaches’
presentation, the Detectives will be able to ask questions.

Remind the Detectives that they are expected to listen and be respectful.
Step 2: The Presentation
The Coaches will present their information and answer questions. Then they will read the All

Points Bulletin (APB) from Headquarters. The APB will provide the Detectives with the next
step in The Great Energy Caper and will encourage them to plan their Stakeout.
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A Message From Headquarters

Dear Detectives!

Headquarters has issued an All Points Bulletin. Behavior Burglars
and Leaky Looters have been spotted in the area of your school.
Behavior Burglars have been seen wasting energy by leaving on lights
and equipment when no one’s using them.

Behavior Burglars have also teamed up with Leaky Looters to leave

windows and doors open and to create leaks all throughout the
building.

Good Luck!

X

Leaky Looters %
Headquarters Behavior Burglars

Sl
S
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v *? Case 6: Planning the Stakeout
N

= ' & Goal: Students Will Prepare to Conduct the Stakeout
Objectives: » Provide Students with Experience Organizing
an Event
> Provide Students with Experience Using the
Team Meeting Format
> Develop the Schedule, Tasks and

Assignments for Conducting the Stakeout

Time Required: 1 After-School Session
Materials Required Learning Standards Addressed
Floor Plan of the School, Stakeout Language Arts:
Forms, Meeting Agenda and Chalk Goals4 Aand B
Board or Large Writing Surface Math:
Goals 6 A, B, Cand D; and
Student Handouts 10B
Meeting Agenda, Stakeout Form
and All Points Bulletin Applied Learning Standards Addressed
Solving Problems, Communicating
Assessment Tool and Working on Teams

Meeting Rubric
Vocabulary Words
Agenda: (noun) A list of items to be discussed at a meeting
Goal: (noun) An aim or desired result
Objectives: (noun) Smaller goals, the steps you take to achieve your goal
Territory: (noun) An area in which one has certain rights or responsibilities

Stakeout: (verb) Watch a place or person

Procedure
Using a team meeting format, students will organize themselves to conduct a Stakeout of
the Behavior Burglars and the Leaky Looters.

Step 1: Introduce the Lesson

Explain to your Detectives that it is time to plan the Stakeout. This will be done in a team
meeting. Begin by asking them to sit in a circle. Then, provide them with the meeting
agenda, the All Points Bulletin and a copy of the Stakeout Form. Give them time to look over
both.
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Step 2: Icebreaker

Ask the students to introduce themselves as if they were an energy thief. To do this, have
them use their first name followed by an energy wasting activity beginning with the first
letter of their first name (ie. Ann Always Leaving Lights On).

Step 3: Request a Volunteer
Request a volunteer to serve as note taker.

Step 4: Begin the Meeting

Agenda
Goal: Plan a successful Stakeout of our school. During the Stakeout,
Detectives will look during the school day and after school for
the Behavior Burglars and Leaky Looters.
Objectives: » Establish teams so that a Stakeout Form is completed
for each room in the school
> Provide teams with materials they will need like enough
Stakeout Forms and a list of rooms to visit
> Provide a place for teams to take their completed forms
Task 1: Discuss Strategy
The teacher should review the goals and objectives of the meeting so that
everyone knows what will be discussed.
Task 2: Establish Teams
As a group, determine how many Detectives should be on a team. Some
questions to consider are:
What jobs need to be done?
Should there be an even number or an odd number on each team?
Once decided, determine how to assign Detectives. Then write each
Detective’s team assignment on the back of their Detective ID card.
Task 3: Territory

Determine each team’s territory by identifying the rooms for which they
should complete Stakeout Forms. Remember, each team should have about
the same amount of work.

One way to do this would be to divide the number of hallways by the number
of teams. This would tell you how many hallways (and all the rooms attached
to them) each team would cover. Can you think of other ways to divide up the
school?
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Task 4: Time Frame
Determine how many days you will spend on your Stakeout.

Task 5: Materials / Permission
Once you know how many rooms each team will be visiting, you can
determine what materials they will need. This will include:
Pencils with erasers
Clip Boards or some hard surface to write on
Stakeout Forms - including some extras in case there is a problem
Permission from Principal
Help getting into locked rooms from Janitors, etc.

You will also determine who will be responsible for getting the materials,
permission and assistance.

Task 6: Review the Stakeout Form and Procedures
Review the form to make sure that all Detectives understand how to fill it out.
It is important that the information be absolutely correct.

Remind all the Detectives to be quiet while doing the Stakeout so that energy
thieves do not know they are being watched.

Tell all Detectives where to pick up their materials and where to drop off their
completed Stakeout Forms.

Step 5: End Meeting
This is a good time for questions. Be sure that all Detectives have had a chance to have
their questions answered.
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Energy Detectives Stakeout Form

Looking for Behavior Burglars and Leaky Looters

Date: Detective(s):

Please Circle the Time of Day You Conducted Your Stakeout and the Key that Describes
What You Found:

Time of Day: Key:
Morning + Room Occupied - Energy Used Wisely
Afternoon - Room Occupied - Energy Not Used Wisely
After School E+ Room Not Occupied - Energy Not in Use
After School E- Room Not Occupied - Energy in Use
Location:
Room # - or - Room Description (Office, Closet, Hallway, etc.)
'.‘a ..Oo,
Please Circle Any Energy Crimes You Found: ‘

Lights On But No One’s Home
Lights On But Not Necessary - Sunlight Available
Equipment On But No One’s Home

Leaks/Drips: A Hot Water - or - O Cold Water

Drafts Around: O Doors - and/or - A Windows

Windows Open: Heat or Air Conditioning On

Outside Doors Open

Recyclables Found in Trash: O Paper A Aluminum Cans
Comments:
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Meeting Rubric
Listening and Asking Questions for Clarification

Student Name:

Listen attentively by facing the speaker and making eye contact.

1 2 3 4 5 X 4=
Poor Excellent

Demonstrate ways that listening attentively can improve comprehension
such as asking probing questions, providing feedback to the speaker,
summarizing and paraphrasing complex spoken messages.

x4 =
1 2 3 4 5
Poor Excellent
Ask questions and respond to questions to improve comprehension.
1 2 3 4 5 x4 =
Poor Excellent
Use good grammar and manners when asking or responding to questions.
1 2 3 4 5 x4 =
Poor Excellent
Apply listening skills such as note taking, waiting to ask questions until
timing is appropriate, not asking a question which has already been asked
and answered.
1 2 3 4 5 X4 =

Poor Excellent

Total Score
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Energy Detectives Stakeout Form

Date: Detective(s):

Time of Day: Key:
Morning + Room Occupied - Energy Used Wisely
Afternoon - Room Occupied - Energy Not Used Wisely
After School E+ Room Not Occupied - Energy Not in Use
After School E- Room Not Occupied - Energy in Use

Location:

Room # - or - Room Description (Office, Closet, Hallway, etc.)

Energy Crime:

Lights On But No One’s Home

Lights On But Not Necessary - Sunlight Available
Equipment On But No One’s Home

Leaks/Drips: QO Hot Water -or- (O Cold Water
Drafts Around:( Doors - and/or - OO Windows
Windows Open / Heat or Air Conditioning On
Outside Doors Open

Recyclables Found in Trash: O Paper A Aluminum Cans

DDDDDDDD

Comments:
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("% Case 7: The Stakeout

i e ? 7 Goal: Students Will Conduct the Stakeout
el L e s
. o / o Objectives: » Observe the Energy Behaviors and Comfort
' : Levels in All Rooms Within the School
> Complete Stakeout Forms Correctly for All
Rooms Within the School
Time Required: Several After-School Sessions
Materials Required Learning Standards Addressed
Floor Plan of the School, Language Arts:
Stakeout Forms, Hall Passes Goals3BandC; 4 A
and Any Materials Math:
Determined During the Goals 6 A and C
Previous Team Meeting Science:
Goals 11 A; 12 C; 13 A
Student Handouts and B

Stakeout Forms
Applied Learning Standards Addressed

Assessment Tool Solving Problems,
Review Completed Stakeout Communicating and
Forms Working on Teams
Procedure

Detectives will look both during the school day and after school for Behavior Burglars by
seeing how energy is used in each room in the
school.

During their after school time, Detectives will % Supervision Options

look for Leaky Looters by looking at the During Stakeout
school’s walls, doors, windows and water
faucets for leaks, drips and gaps. > You may choose to spot check

the student’s activities.
Step 1: Gather Teams

Take attendance at the beginning and end of > You might ask an authority
each Stakeout period. Be sure the students figure to be present on each
know their task, have their materials and have floor in case the students have
been reminded to move through the school questions or require
quietly. Establish a time when they should supervision.
return to the classroom.

> You may choose to be available
Step 2: After Stakeout in your classroom if students
Collect Stakeout Forms and thank the students have questions.

for their efforts.
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("% Case 8:

The Suspects

L Rty Goal: Detectives Will Review Their Stakeout Forms to
T ‘ b Determine Potential Areas of Energy Inefficiencies
Objectives: » Provide Students With Experience Analyzing
Non-Numerical Data
> Provide Students With Experience Making
Decisions in Small Groups
> Prepare a Short Presentation to the Class
Time Required: 1 After-School Session

Materials Required
Completed Stakeout Forms,
Several Suspect Forms, Several
Presentation Forms, Calculators for
each Stakeout Team and (optional)
Access to Internet

ﬂ Invite the Energy Coaches to
Participate in this Session

Student Handouts
Completed Stakeout Forms,
Several Presentation Forms

Assessment Tool
Review Completed Presentation
Form and Suspects Form

Procedure

Learning Standards Addressed
Language Arts:
Goals 1 B; 3C; 4 A and B;
5AandC

Math:
Goals6 A, BandC; 10A, B
and C
Science:
Goals 11 A; 12 C; 13 A
and B

Applied Learning Standards Addressed
Solving Problems, Communicating,
Working on Teams and Making
Connections

The Energy Coaches will work with each Stakeout team to help students review their

Stakeout Forms, organize their findings an

d complete a Suspect Form.

If desired, they can contact FliP the Switch for assistance.
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Step 1: Introduce Activity

Explain that it is the responsibility of each Stakeout Team - with assistance from a team of
Energy Coaches - to analyze their Stakeout Forms. By reviewing the data they collected on
the Stakeouts, Detectives will be able to identify suspected energy wasters. This information
will be presented at the next after-school session and will be used to identify an Action Plan.
A Presentation Form has been developed for their use.

Ask one member of each Stakeout Team to collect the appropriate Stakeout Forms from you
as students regroup into their Stakeout Teams with the Energy Coaches.

Step 2: Work in Small Groups

Students will work in their Stakeout Teams with a team of Energy Coaches to first complete
the Presentation Form and then the Suspect Form. Each group will also need to identify who
will present this information to the rest of the team at the next after-school session.
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Presentation Form

The following form will help you organize your thoughts.

We visited (#) roomsonthe (1%, 2", etc) floor and on the
(North, South, etc) side of the building.

(NOTE: Please use another form if you visited rooms on more than one floor or more than
one side of the building.)

We visited these rooms during —_______(time of the day).

We found it uncomfortably hot in the following rooms:

We found it uncomfortably cold in the following rooms:

We believe this is due to:
(Temperature settings, doors and/or windows open or leaking, blinds not closed, etc. Please
be as specific as possible.)

Room Cause

We found (lights, equipment, water, etc. Please be as specific as
possible.) left on in the following rooms:

We found (broken windows, cracks, dripping faucets, no weatherstripping and/or no
caulking) in the following rooms:
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Suspect Form

Behavior Burglar Suspects Possible Crimes

Leaky Looter Suspects Possible Crimes
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40 Case 9:  Developing an Action Plan
& e Parts A and B
La‘.;_".?_ '
i "‘"f}” L / Goal: Students Will Agree Upon the Most Significant
e o I‘:" b

Energy Wasters and Will Develop an Action Plan to
Reduce the School’s Energy Use

Objectives: » Provide Students With Experience Presenting
Information both Verbally and Visually
> Provide Students With Experience Using the
Team Meeting Format
> Provide Students With Experience Making
Decisions in Large and Small Groups
> Provide Students With Experience
Developing a Work Plan
> Provide Students With Experience
Evaluating Their Own Skills
Time Required: Two After-School SessionS
Day 1 - Part A
Materials Required Learning Standards Addressed
Completed Suspect Forms, Meeting Language Arts:
Agenda and Chalk Board or Large Goals 1 B; 3C; 4 A and B;
Writing Surface 5AandC
Math:
Student Handouts Goals 6 A, B, Cand D; 10 A,
Suspect Forms and Meeting B and C
Agenda Science:
Goals 11 Aand B; 12 C; 13
Assessment Tool Aand B

Meeting Rubric

Applied Learning Standards Addressed
Solving Problems, Communicating,
Working on Teams and Making
Connections

Procedure

Using the team meeting format, students will identify the significant energy wasters, will

develop the activities which will be included in the Action Plan to reduce energy use and will
develop the Action Plan.
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Part A

Step 1: Introduce the Lesson
Tell students that today’s goal is to conduct a meeting that includes the presentation of
information and the use of that information to reach conclusions. During the next meeting
they will develop a plan to act on that
information.

Ground Rules
You will need their cooperation following the

four ground rules for a successful meeting.

No Interrupting

Be Respectful of Each Other
Listen to Understand
Everyone Participates

It is a good idea to write those ground rules on
a large piece of paper so that everyone can see
them throughout the meeting.

DR

Step 2: Share the Meeting Agenda
After reviewing the ground rules, distribute or

post the meeting agenda. Also, request 1-2 % NOTE To Teacher:
volunteers to serve as note takers. They should An annotated meeting agenda is
write their notes on the board. attached for your use and a non-

annotated agenda is provided for
use by the students.

Step 3: Conduct the Meeting

Decision Making Meeting Agenda for Use by the Teacher

Review the Agenda
Teacher will review the meeting agenda.

Presentations
Stakeout teams will each have 3 minutes to present their findings. After each presentation,
the rest of the Detectives should be provided an opportunity to ask questions.

Combine Data

Using the Stakeout Form, the meeting note takers should keep track of the total number of
rooms visited and the total number of each type of Energy Crime reported. For example, the
note takers should indicate how many rooms had “Lights On But No One’s Home.”

It may be helpful to determine the percentages associated with each Energy Crime. This
would be done by dividing the total number of occurrences for each crime by the total
number of rooms visited. For example, if 60 rooms had “Lights On But No One’s Home"” and
the school has 120 rooms, then 60 divided by 120 = 50%.

Identify the Suspects

Using the combined data, the Detectives should determine -as a group - the most serious
suspects. The note takers should list these on the board.
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Reform the Suspects / Reward Good Citizens
The meeting leader should ask the Detectives to brainstorm possible ways of reforming the
suspects and rewarding good citizens. A description of brainstorming follows:

Ask the note takers to draw two columns on the board. One should be labeled “"Reform” and
the other “Reward.” The Detectives should identify if they are suggesting a Reform or a
Reward suggestion. The suggestions can then be written under the appropriate column.

Reward

Decision Point

First make sure that everyone understands the ideas presented during brainstorming. If
anyone needs an idea explained, take time to do that. Once everyone understands the
ideas, it is time to choose the ideas which will be included in the Action Plan. There are two
steps in this process. First, ask the Detectives to look at the list and decide if any of the
ideas are similar and can be combined. If they can be combined, do so.

After all similar ideas have been combined, the Detectives will be asked to vote on the ideas
to be included in the Action Plan. Using a show of hands, allow the Detectives to vote for the
ideas they want to include in the Action Plan. During the first round, a Detective can vote for
as many ideas as they like. You should end up with a group of ideas in each category with a
lot of votes and then a group with few votes. Eliminate the ideas with few votes. If you have
less than 10 ideas and you think you can handle all of them, then you are ready to move on
to the Action Plan.

If you still have too many ideas, conduct another vote allowing each Detective two votes.
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Decision Making Meeting Agenda

WHAT

WHO

Review Agenda:

Goal:

To Identify the Energy Suspects
and

Determine Ways to Reform the
Suspects and Reward Good Citizens

GOAL

Teacher

Presentations:
Each Stakeout Team Will Describe What
They Found Using the Presentation Form

Stakeout Teams (3 minutes each)

Combine Data

Note Takers

Identify Suspects

All Detectives
Led by Teacher

Brainstorm:
Ways to Reform the Suspects and
Reward Good Citizens

All Detectives
Led by Teacher
Note Takers Write Down Ideas

Clarify and Combine Ideas from
Brainstorming

All Detectives
Led by Teacher

Decision Point:

Identify the Ways Your Detective Agency
will Reform the Suspects and Reward Good
Citizens

All Detectives
Led by Teacher
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Day 2 - Part B

Materials Required Learning Standards Addressed
Action Plan, Sample Action Plan Language Arts:
Either as a Handout or Overhead, Goals 1 B; 3C; 4 A and B;
Overhead Projector, Self 4AandB; 5A
Assessment Form, List of Reform Math:
and Reward Activities Developed Goals6 A,Band C; 10 C
During Class #1, Post-it Notes and Science:
Chalk Board or Large Writing Goal 12 C
Surface
Invite the Energy Coaches to Applied Learning Standards Addressed
Join You for the Last Half of Solving Problems, Communicating,
This Session Working on Teams and Making

Connections
Student Handouts
Sample Action Plan (optional), Self
Assessment Form

Assessment Tool
Completed Action Plan

Part B

Step 1: Introduce Lesson

Tell students that today’s goal is to use the activities chosen during the last class to develop
an Action Plan to reform the Behavior Burglars and the Leaky Looters. The Detectives will
implement this Plan while the Coaches work on activities related to reforming the Evil
Equipment and Air Abductor Gangs. The Coaches and FliP the Switch will be available to
help the Detectives.

GOAL Goal
To Catch and Reform the Behavior Burglars and Leaky Looters at Our School

Step 2: Introduce the Action Plan

An Action Plan is an organized way of planning an activity. First, the Plan lists each major
activity and then breaks it down into smaller parts. For instance, if you were planning a
birthday party in your classroom you might break it into 5 parts:

4 Invitations
4 Food

4 Decorations
4 Games

4 Thank You Notes
Next, each of these parts have to be planned. You need to decide who will be responsible for

each, what those responsible will need, when they should have their part completed and
how to determine if they completed their work successfully.
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N\ NOTE To Teacher:

A completed chart is provided as an
example.

N\ NOTE To Teacher:

It is now time to invite the Coaches to
join you. They have been doing similar
work to prepare for developing the
Action Plan.
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Step 5: Group Review
Ask the entire group to review the forms and write any suggestions on Post-it Notes next to
the appropriate form.

After this process is complete, read the Post-it Notes, discuss the suggestion and decide as a
group whether to accept or reject the suggestion.

Once this is completed, you will have an Action Plan.

Step 6: Make Assignments

It is time to make assignments. Each Reform and Reward activity which has an Action Plan
will need a committee leader. Those who said they were good at planning and organizing
would make good committee leaders. Ask those people to choose an activity to lead. Do you
have too many or too few committee leaders? If so, ask the entire group what they suggest.
A solution will emerge which will either be the consensus of the group or the teacher can
choose.

Next, ask the remaining students to select a
committee or committees for which they will % .
work. They should tell the committee leader e e
what tasks they would like to do. The
committee leader will accept committee
members until all tasks have been filled.

It is possible for a student to be on
several committees. For instance, if
they excel at drawing, they could be
viewed as the artist in residence who
is responsible for completing tasks for
several committees.

Step 7: Conclusion

Congratulate the Detectives and Coaches on
their successful work. Tell them that during the
next class, committees will begin their work.
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Self Assessment Form
(Check all that apply)

I am good at:

I T O O o A

Drawing

Using Clip Art on the Computer
Math

Planning and Organizing
Speaking over the P.A. System
Speaking in Front of People
Typing

Writing Plays or Stories
Writing Letters

Writing Songs

Singing

Graphing Using the Computer
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Major Activity:

Invitations

Action Plan

Activity

Assigned To

Resources Needed

Due Date

Assessment

Address Invitations

2 people with good
handwriting

List of People to Invite

Invitations and
Envelopes

2 weeks before party

Deliver Invitations

If mailed, 2 people
who are responsible

If delivered, 2 people
who are responsible
and comfortable
talking with others

Stamps or Hand
Delivery

2 weeks before party

Were invitations sent
to everyone on the
list?

Track RSVP’s - Call if
necessary

1 person who can
create a chart either
on the computer or
neatly on paper

1 person to track
RSVP’s who is
organized and
responsible

Chart

1 week before party
track the number of
RSVP’s and contact
those you haven't
heard from

Tell Other Committees
How Many People to
Expect

The same person who
has been tracking the
RSVP’s

Chart

1 weeks before party,
2 days before party
and the day before the

party

How many people did
you expect and how
many people actually
came?
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Energy Detectives Action Plan

Activity

Assigned To

Resources Needed

Due Date

Status
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Energy Coaches Action Plan

Activity Assigned To Resources Needed Due Date Status
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4 ("% Case 10:  Reforming the Energy Thieves

i ﬂﬂ Goal: Students Will Implement Their Action Plan
e ML |
A o . . . .
| Objectives: » Provide Students With Experience Working
L in Teams to Accomplish a Common Goal
> Help Students Track Their Progress and
Adjust Their Activities as Necessary
> Show Students that a Variety of Content
Skills are Necessary to Accomplish Their
Task
Time Required: The Remainder of the School Year
Materials Required Learning Standards Addressed
Identified in the Action Plan Language Arts:
Developed by the Students Goals1 A, BandC; 3A, B
and C; 4 A and B;
Student Handouts 5A,BandC
Action Plan Forms for Tracking Math:
Progress Goals 6 A, B, Cand D; 8 A,
B,Cand D; 10 A,Band C
Applied Learning Standards Addressed Science:
Solving Problems, Communicating, Goals 11 A and B; 12 C and
Using Technology, Working on E; 13B
Teams and Making Connections Fine Arts:

Goals 25 B; 26 Aand B

Procedure

Working in their committees, students will implement the Action Plan they developed. This
activity will continue throughout the school year, even though additional tasks will be
happening as well.

Step 1: Tracking Progress

Teachers, during the implementation of the Action Plan, committees will be working on
separate and distinct tasks. You will want to work closely with the committee leaders to
review upcoming activities, track progress and assess student learning and participation.
This is where the Status column on the Action Plan is used.

It is suggested that a regular meeting time (preferably the end of the after-school session)
be established when all committee leaders present the status of their Action Plan. During
the meeting you might ask one of the committee leaders to take notes for you. This can be
done using the following agenda or you may choose another format that better suits your
needs. The choice is yours.
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Meeting Agenda
Action Plan Status

Committee Leaders Daily Report:
Committee Leaders, please respond to the following
questions:

“Did you meet your goals for today?
Why or why not?”

Committee Leaders Goals:
Committee Leaders, please respond to the following
questions:

“What are your goals for the next class?
What will you need?”

Problems or Issues:
Committee Leaders, are you having any problems that you
would like to discuss?

Step 2: Sharing Progress
Teachers, you are encouraged to provide all
Detectives with a regular update on the
progress of the Detective Agency. This can be % NOTE To Teacher:

done by posting the updated Action Plan sheets | Students may be out of the classroom

on a bulletin board, asking committees to give for a portion of time while they are
reports, having a communications committee conducting Action Plan activities.
that posts the Detective Agency’s progress on Those who will be leaving the

the online Detective Discussion Area or classroom should first report for
producing a newsletter. attendance, receive a hall pass (if

necessary), and be told what time
they are expected to be back in the

Remember that the EnergyNet classroom. Students must report back
4 staff and/or FliP the Switch are to the classroom before leaving for the
AW available to help. Contact us day.
L BV either by telephone toll-free at
“¥) 877/359-ENET (3638) or by Ask a student to create a chart that
email. Students should be lists each student’s name followed by
encouraged to post their a box the size of a post-it note. In the
questions on the Detectives box, write In. If the student will be out
Discussion Area on the web site. | of the class for a portion of time, write
Feel free to add to this section their location, activity and the time
by posting your own questions or helpful hints they are expected back on a post-it
on the web site. note and place it in this first column.
Hang this chart in an easy to see
location.
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4 ("% Case 11: All Points Bulletin . . .

o The Home Front
T %_: r Parts A and B

! Goal: Introduce Students to Residential Energy Efficiency
o Opportunities

Objectives: » Give Students the Opportunity to Apply Their Knowledge in a
Residential Setting
> Expand the Energy Efficiency Opportunities the Students
Consider
> Reinforce the Energy Knowledge Students Have Obtained
Time Required: 1 After School Session
Part A
Materials Required Learning Standards Addressed
All Points Bulletin from Language Arts:
Headquarters, 1 Computer with Goals3Band4 A
Projection Capability, Guest Science:
Speaker on Demand CD-ROM: At Goals12Cand 13 B
Home With Diva and Outline of
PowerPoint for Each Student Applied Learning Standards Addressed
Communicating, Using Technology,
Student Handouts Working on Teams and Making
Outline of PowerPoint Presentation Connections

Introduce the Topic
Headquarters has issued another All Points Bulletin. It appears that the Energy Thieves have

begun invading the neighborhood. Many families have filed complaints about high energy
bills and uncomfortable conditions.

Headquarters has asked FliP’s friend Diva to brief the Detectives on ways to detect energy

thieves in homes. As they listen to Diva’s presentation, encourage the Detectives to write
questions and notes on the PowerPoint outline.
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Run the Presentation: At Home With Diva

At Home With Diva is a narrated PowerPoint Presentation. Click on the
PowerPoint presentation icon on your desktop. Click on Slide Show and
then on View Show. The show will run itself. Each slide contains its
own narration and animation. Distribute the PowerPoint outline to
each student.

Discuss the Presentation
Allow the students to process what they’ve heard by discussing it in the classroom. This can

be done in a number of ways such as holding a facilitated discussion and/or organizing a
panel discussion. Suggestions for topics include:

> What areas in your home do you expect are the major energy users
> What ideas would you suggest for modifying your family’s energy behaviors
> What key words would you use to search online for resources which would be

especially helpful to the project
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A Message From Headquarters

Dear Detectives!

Thank you for working to solve The Great Energy Caper! What have
you discovered so far?

Headquarters has issued an All Points Bulletin. Notorious energy

thieves have been seen in your neighborhood. Many families have filed
complaints about high energy bills and uncomfortable conditions.

Sort of like this =

Headquarters has asked FliP’s friend Diva to brief the Detectives on
ways to detect energy thieves in homes.

Good luck!

X

Headquarters
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Day 2 - Part B

Materials Required Learning Standards Addressed
1 Computer with Projection Language Arts:
Capability, Guest Speaker on Goals3 Band 4 A
Demand CD-ROM: Let’s Talk About Science:
Lighting and Outline of PowerPoint Goals 12 Cand 13 B

for Each Student
Applied Learning Standards Addressed

Student Handouts Communicating, Using Technology,

Outline of PowerPoint Presentation Working on Teams and Making

Connections

Assessment Tool

Quiz Covering At Home With Diva

and Let’s Talk About Lighting

R Run the Presentation: Let’s Talk About Lighting
7 /;’ Let’s Talk About Lighting is a narrated PowerPoint Presentation. Click
’ 4 on the PowerPoint presentation icon on your desktop. Click on Slide
Show and then on View Show. The show will run itself. Each slide
— s contains its own narration and animation. Distribute the PowerPoint

o"' outline to each student.
s =

——

Discuss the Presentation

Allow the students to process what they’ve heard by discussing it in the classroom. This can
be done in a humber of ways such as holding a facilitated discussion and/or organizing a
panel discussion. Suggestions for topics include:

> What areas in your home do you expect are the major energy users
> What ideas would you suggest for modifying your family’s energy behaviors
> What key words would you use to search online for resources which would be

especially helpful to the project
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Quiz
At Home With Diva

Name:

The building envelope includes five features of a home. Name four of the five:

Name two types of insulation:

What do you do with a caulking gun?

Filling in the small gaps around windows and doors add up to big energy savings. Fill
in the blank: The average house contains cracks and gaps between building
materials that add up to a hole about square.

Compact Fluorescent replace what lamps?

Outdoor gas lamps waste energy. Replace them with solar powered lamps. What can
you do with the natural gas from just eight gas lamps burning year round?

Name two ways to reduce the use of energy associated with hot water?

Fill in the blank: Things that make use the most energy.
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9. Rank the following tasks in order of energy use with #1 using the most energy:

Water Heating

Lighting and Appliances

Heating and Cooling
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Answer Key
At Home With Diva

1. The building envelope includes five features of a home. Name four of the
five:
(3 points per correct answer - total of 12 points)
Windows Doors Roof
Floors Walls
Name two types of insulation: Cellulose Radiant Barrier
(5 points per correct answer - total of 10) Fiberglass

What do you do with a caulking gun? (10 points) Fill in gaps around windows

Filling in the small gaps around windows and doors add up to big energy savings. Fill
in the blank: The average house contains cracks and gaps between building
materials that add up to a hole about 14 inches square. (10 points)

Compact Fluorescent replace what lamps? (10 points) Incandescent

Outdoor gas lamps waste energy. Replace them with solar powered lamps. What can
you do with the natural gas from just eight gas lamps burning year round? (10
points)

Heat an average size home for a winter

Name two ways to reduce the use of energy associated with hot water? (5 points
each - total of 10 points)

Install low-flow shower heads and faucets

Insulate the water heater

Only run dishwashers when they’re full

Buy energy efficient washers and dishwashers

Fill in the blank: Things that make heat use the most energy. (10 points)

Rank the following tasks in order of energy use with #1 using the most energy: (6
points each - total of 18 points)

#3 Water Heating
#2 Lighting and Appliances
#1 Heating and Cooling
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@ . Case 12: Securing the Home Front

Goal: Students Will Prepare to Conduct a Stakeout at
Their Homes

Objectives: Develop the Schedule, Tasks and Assignments for
Conducting a Stakeout at Their Individual Homes

Time Required: 1 After-School Session
Materials Required Learning Standards Addressed
Home Stakeout Forms, Meeting Language Arts:
Agenda and Chalk Board or Large Goals4 Aand B
Writing Surface, Internet Access Math:
Goals 6 A, B, Cand D; and
Student Handouts 10B
Meeting Agenda, Stakeout Form
and All Points Bulletin Applied Learning Standards Addressed
Solving Problems, Communicating
Assessment Tool and Working on Teams

Meeting Rubric

Procedure

Using a team meeting format, students will plan to conduct a Stakeout of the individual
homes. They will be looking for Behavior Burglars and the Leaky Looters as well as the Con
Men: Evil Equipment, Lighting Larceny and Air Abductors.

Step 1: Introduce the Lesson

Explain to your Detectives that it is time to share their knowledge with their families. Begin
by asking them to sit in a circle. Then, provide them with the meeting agenda, the All Points
Bulletin and a copy of the Home Stakeout Form. Give them time to look over both.

Step 2: Icebreaker
Ask each student to name one thing that’s different about a place where you live versus
their school.

Step 3: Request a Volunteer
Request a volunteer to serve as note taker.

Step 4: Begin the Meeting

Copyright © EnergyNet Page 66



Agenda

Goal:

Plan a successful Stakeout of your home. During the Stakeout,
Detectives will look for the Behavior Burglars and Leaky Looters
as well as the con men: Evil Equipment, Lighting Larceny and
Air Abductors.

Objectives: » Review the Home Stakeout Form

> Establish a Time Frame for Completing the Home
Stakeout

Task 1:

Task 2:

Task 3:

Task 4:

Discuss Strategy
The teacher should review the goals and objectives of the meeting so that
everyone knows what will be discussed.

Time Frame
Determine how many days you will spend on your Home Stakeout

Review the Home Stakeout Form
Review the form to make sure that all Detectives understand how to fill it out.
It is important that the information be absolutely correct.

Remind all the Detectives to be quiet while doing the Stakeout so their family
doesn’t know they are being watched.

Discuss what will be different about the Home Stakeout versus the School
Stakeout. What are they likely to find?

Tell all Detectives where to pick up their materials and where to drop off their
completed Stakeout Forms.

Review Safety Concerns
Play the Home Safety Audit Game at:
www.SafeElectricity.org/esw_v1-1/safe choice/game.html

Remind the Detectives:

> Never put their fingers or anything inappropriate into electric sockets
> Don’t touch the furnace, boiler or water heater
> Don’t go on the roof

Step 5: End Meeting
This is a good time for questions. Be sure that all Detectives have had a chance to have
their questions answered.
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Home Stakeout Form

Date: Detective(s):

Please circle the time of day you conducted your stakeout and the key that describes what
you found:

Time of Day: Key:
Morning + Room Occupied - Energy Used Wisely
Afternoon - Room Occupied - Energy Not Used Wisely
Evening E+ Room Not Occupied - Energy Not in Use
E- Room Not Occupied - Energy in Use
Location:

Room Description (Bedroom, Kitchen, Hallway, etc.)

Was the Room:
Comfortable Hot Cold

Behavior Burglars
Please circle any signs of Behavior Burglars you found:

Lights On But No One’s Home
Lights On But Not Necessary - Sunlight Available
Equipment On But No One’s Home

Leaks/Drips: O Hot Water - or - O Cold Water
Drafts Around: O Doors - and/or - O Windows
Windows Open: Heat or Air Conditioning On

Curtains Open
Outside Doors Open
Recyclables Found in Trash: O Paper A Aluminum Cans/Glass

Comments:
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Leaky Looters
From inside and outside your home, you can look for signs of Leaky Looters.

Please circle any of these signs of Leaky Looters that you found:

Drafty Windows:

Loose fitting No storm window Storm window open
Drafty Outside Walls:

Around electric outlets Around plumbing Other
Drafty Outside Doors:

Gaps around doors Loose windows in doors
Foundation has Cracks:

Around bricks Around concrete Other

If you can safely get to the attic or basement, did you find any insulation?
Yes, pink fiberglass Yes, cellulose No

Comments:

Lighting Larceny
Look at the lighting inside and outside your home. Please circle any of these signs of
Lighting Larceny that you found:

Incandescent Light Bulbs: How many?
Halogen Bulbs: How many?

If there were lights left on when no one was in the room, circle the kind of lights:

Incandescent How many?
Halogen How many?
Fluorescent How many?
LED How many?

What type of outside lights and/or common area lights are in your home?

Incandescent How many?
Fluorescent How many?
Other How many?
Are any lights on a motion sensor? How many?

Comments:
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Evil Equipment
Please circle any signs of Evil Equipment that you found:

Chargers plugged into the wall with no cell phone or games plugged into the charger
“Instant on” equipment plugged in (Like plasma televisions)

Equipment left on when not in use (Like computers and stereos)

Water heaters without an insulating blanket

Your water heater was set above 140 degrees

Extra refrigerators

Leaky refrigerators

Refrigerators with dirty coils (Only look at coils on the front of the refrigerator. Do
not attempt to move the refrigerator.)

Comments:

Air Abductors
If you can easily see the type of heating/cooling systems you have, please circle them
below. Otherwise, indicate that they are not easy to see.

Natural gas forced air furnace
Natural gas boiler
Electric heat

Other

Window air conditioner(s) How many?
Central air conditioning

None

Other

If you have radiators, are they clean?

If you have vents, are they blocked by furniture, etc?

If you have window air conditioners, are they removed in the winter?

If they are not removed in the winter, are they covered or sealed in the winter?
Do you have a programmable thermostat?

What temperature is your thermostat set at during the day? At night?

Comments:
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Meeting Rubric
Listening and Asking Questions for Clarification

Student Name:

Listen attentively by facing the speaker and making eye contact.

1 2 3 4 5 X 4=
Poor Excellent

Demonstrate ways that listening attentively can improve comprehension
such as asking probing questions, providing feedback to the speaker,
summarizing and paraphrasing complex spoken messages.

x4 =
1 2 3 4 5
Poor Excellent
Ask questions and respond to questions to improve comprehension.
1 2 3 4 5 x4 =
Poor Excellent
Use good grammar and manners when asking or responding to questions.
1 2 3 4 5 x4 =
Poor Excellent
Apply listening skills such as note taking, waiting to ask questions until
timing is appropriate, not asking a question which has already been asked
and answered.
1 2 3 4 5 X4 =

Poor Excellent

Total Score
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T

4 ("W Case 13: Suspects at Home
[\ Parts A and B

Goal: Detectives Will Review Their Home Stakeout Forms
to Determine Potential Areas of Energy

Inefficiencies

v

Objectives:

Reinforce Students’ Earlier Work Analyzing

Non-Numerical Data

> Provide Students With Experience Making
Decisions in Small Groups
> Prepare a Short Presentation for their Family

Time Required:

Two After-School Sessions

Day 1 - Part A

Materials Required
Completed Stakeout Forms,
Several Suspect Forms, Several
Presentation Forms, Calculators
and (optional) Access to Internet

Invite the Energy Coaches to
Participate in this Session

Student Handouts
Completed Stakeout Forms,
Presentation Forms and Suspect
Forms

Assessment Tool
Review Completed Presentation
Form and Suspects Form

Procedure

The Energy Coaches will work with each
Stakeout team to help students review their
Stakeout Forms, organize their findings and
complete a Suspect Form.

If desired, they can contact FliP the Switch for

assistance.
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Learning Standards Addressed

Language Arts:
Goals 1 B; 3C; 4 A and B;
5AandC

Math:
Goals6 A,BandC; 10A, B
and C

Science:
Goals 11 A; 12C; 13 A
and B

Applied Learning Standards Addressed
Solving Problems, Communicating,
Working on Teams and Making
Connections

N Note to Teachers

This lesson is similar to Case 8
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Step 1: Introduce Activity

Explain that it is the responsibility of each student - with assistance from the Energy
Coaches - to analyze their Stakeout Forms. By reviewing the data they collected at their
homes, Detectives will be able to identify suspected energy wasters. This information will be
presented at the next after-school session and will be used to identify an Action Plan. A
Presentation Form has been developed for their use.

Step 2: Work in Small Groups

The Energy Coaches will have also completed a Stakeout of their homes so they will begin
by discussing the information they collected. The Coaches will complete their Presentation
Form and will then work with the Detectives to review their information and complete their
Presentation form.

Following the same process, the Coaches and Detectives will complete their Suspect Forms.

Each group will also need to identify who will present this information to the rest of the
team at the next after-school session.
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Presentation Form

The following form will help you organize your thoughts.

We found it uncomfortably hot in the following rooms: (Note: Please indicate if the rooms
were on the North, South, East or West)

We found it uncomfortably cold in the following rooms: (Note: Please indicate if the rooms
were on the North, South, East or West)

We believe this is due to:
(Temperature settings, doors and/or windows open or leaking, blinds not closed, etc. Please
be as specific as possible.)

Room Cause

We found (lights, equipment, water, etc. Please be as specific as
possible.) left on in the following rooms:

We found (broken windows, cracks, dripping faucets, no weatherstripping and/or no
caulking) in the following rooms:
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Suspects Form

Behavior Burglar Suspects Possible Crimes
Leaky Looter Suspects Possible Crimes
Lighting Larceny Possible Crimes
Evil Equipment Possible Crimes

Air Abductors Possible Crimes
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Day 2 - Part B

Materials Required Learning Standards Addressed
Completed Suspects and Language Arts:
Presentation Forms Goals4 Aand B; 5Aand C
Science:
Invite the Energy Coaches to Goals 12 Cand E
Participate in this Session
Applied Learning Standards Addressed
Solving Problems, Communicating,
Student Handouts Working on Teams and Making
Completed Suspects and Connections

Presentation Forms

Assessment Tool
Presentation Rubric

Step 1: Introduce Activity

Students will be practicing the presentations they will make to their families. Remind the
Detectives that it is important that they listen, be polite and be prepared to offer any advice
that may be helpful.

Step 2: Presentations

The Coaches and Detectives will give their presentation about what they found during their
Stakeouts. Depending upon the number of students you have, you may choose to have each
student give their presentation to the entire group, or you may divide into small groups.
Allow time at the end of each presentation for questions and suggestions.
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Presentation Rubric

Student Name:

Content
Quality - Comprehensive, thorough and reliable information

1 2 3 4 5
Poor Excellent

Organization - Logical flow of ideas / established grouping of related facts
1 2 3 4 5
Poor Excellent

Presentation

Participation - Eager to share and listen to ideas as demonstrated by
verbal and non verbal strategies

1 2 3 4 5
Poor Excellent

Delivery - Appropriate volume, tone and pace; Attention getting,
interesting

1 2 3 4 5

Poor Excellent
Prepared - appropriate and orderly materials

1 2 3 4 5
Poor Excellent
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4 (" Case 14: Developing Your Family's Action Plan

| S “ | Goal: Students Will Identify the Energy Wasters Their
= _r.._..@bf il Family Can Affect and Will Develop an Action Plan
<=l ‘ d to Reduce their Energy Use
Objectives: » Provide Students With Additional Experience
Presenting Information both Verbally and
Visually
> Provide Students With Additional Experience
Using the Team Meeting Format
> Provide Students With Additional Experience
Making Decisions in Large and Small Groups
> Provide Students With Additional Experience
Developing a Work Plan
Time Required: 1 After-School Session
Materials Required Learning Standards Addressed
Action Plan Form, Skills Language Arts:
Assessment Form, Letter from FliP Goals 1 B; 3C; 4 A and B;
to the Families 4AandB; 5A
Math:
Student Handouts Goals6 A,Band C; 10 C
Action Plan Forms, Skills Science:
Assessment Form, Letter from FIiP Goal 12 C

to the Families
Applied Learning Standards Addressed
Assessment Tool Solving Problems, Communicating,
Completed Action Plan Working on Teams and Making
Connections

Step 1: Introduce Lesson
Tell students that today’s goal is to develop an Action Plan to present to their families..
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Step 2: Review the Action Plan
An Action Plan is an organized way of planning an activity. First, the Plan lists each major
activity and then breaks it down into smaller parts.

Each of these parts have to be planned. You need to decide who will be responsible for each,
what those responsible will need, when they should have their part completed and how to
determine if they completed their work successfully.

Step 3: Skills Assessment Form

The next step in developing your family’s Action Plan is to identify the skills of each member
of your family. You will use this information to suggest tasks based on who has the skills for
the job. [At this point, distribute the form and give each student time to complete it.]

Step 4: Work Individually
Allow each Detective time to complete their Action Plan. When the Detectives are done,
have them post their forms around the room.

Step 5: Organize Material for the Presentation to their Families

The Detectives are now ready to share their suggestions with their family. Provide each of
them a copy of the Letter from FliP and help them gather their materials for their
presentation.

Step 6: Conclusion

Congratulate the Detectives on their successful work. Tell them they will be asked to keep
the group updated on their progress with their family.
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Skills Assessment Form
(Write the Name of Your Family Member(s) That Has the Various Skills)

Who is good at:

Drawing

Using Clip Art on the Computer
Math

Planning and Organizing
Speaking in Front of People
Typing

Writing Plays or Stories
Writing Letters

Writing Songs

Singing

I T O O o o o N e

Graphing Using the Computer
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Energy Detectives’ Home Action Plan

Activity

Assigned To

Resources Needed

Due Date

Status
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Dear Parents:

Your child will be involved with a special project - EnergyNet’s Energy
Detectives. This project has been provided to our school by the Northern
[linois Energy Project and has been developed by EnergyNet .

— Energy Detectives uses a student’s natural curiosity to help them learn
=== Math, Science, Technology and Language Arts. The project meets the
[linois Learning Standards.

Some of the excitement of Energy Detectives is finding its way into your home. Your child is
prepared to share energy tips with you and has developed suggestions of how your family can
reduce your energy bills. By encouraging your child in this activity you will enjoy reduced
energy bills as well as a motivated student.

If you would like to learn more about the project, please visit the EnergyNet web site at
www.energynet.net or call toll-free 877/359-3638.

Sincerely,

and the EnergyNet Team
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4 ("% Case 15: Energy Efficiency at Home

S - "/ Goal: Students Will Implement Their Action Plan at Home

e Objectives: » Provide Students With Experience Working
With their Family to Accomplish a Common
Goal
> Help Students Track Their Progress and
Adjust Their Activities as Necessary
> Show Students that a Variety of Content
Skills are Necessary to Accomplish Their
Task
Time Required: The Remainder of the School Year
Materials Required Learning Standards Addressed
Identified in the Action Plan Language Arts:
Developed by the Students Goals1 A, BandC; 3A,B
and C; 4 A and B;
Student Handouts 5A,BandC
Action Plan Forms for Tracking Math:
Progress Goals 6 A, B, Cand D; 8 A,
B,Cand D; 10 A,Band C
Applied Learning Standards Addressed Science:
Solving Problems, Communicating, Goals 11 A and B; 12 C and
Using Technology, Working on E; 13B
Teams and Making Connections Fine Arts:

Goals 25 B; 26 Aand B

Procedure
Students will implement the Action Plan they developed. This activity will continue
throughout the school year in tandem with their Action Plan for the school.

Step 1: Tracking Progress

Ask students to establish a journal or to use the Action Plan sheets to monitor their
progress. It is also helpful to ask the students to share their progress online with FliP the
Switch and the other schools.
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% "W Case 16: Reporting to Headquarters

e "/ Goal: Students Will Compile and Submit a Written Report
A T ﬂ”’ Ay on Their Project Experiences
~ R
Objectives: » Provide Students With an Opportunity to
Reflect on Their Work
> Provide Students With Experience
Developing a Report as a Team
> Provide Students With Experience Using the

Computer for Word Processing and
Formatting a Document

> Provide Students With an Opportunity to
Practice Their Writing

Time Required: 2 or More After-School Sessions
Materials Required Learning Standards Addressed
Action Plan Forms, Scrapbook, Language Arts:
Scrapbook Accessories (Scissors, Goals 1 Aand B; 3 A, Band
Tape, etc.), Self Assessment, Final C;4AandB; 5A,Band C
Report Outline Math:
8B, CandD; 10 A, Band C
Invite the Energy Coaches to Science:
Participate in These Sessions Goals 11 A; 12 C and E;
13aand B
Student Handouts Fine Arts:
Action Plan Forms, Final Report Goals 25 B; 26 Aand B

Outline, Self Assessment

Applied Learning Standards Addressed
Solving Problems, Communicating,
Using Technology, Working on
Teams and Making Connections

Procedure

Working with the Energy Coaches, students will compile a written report on the activities of
their Detective Agency.

Step 1: Introduce Activity

The Detective Agency has successfully completed their Mission. A final report has been
requested from Headquarters.
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Step 2: Review Final Report Outline
Distribute copies of the Final Report Outline or create an overhead for review purposes.

Ask the Energy Coaches to present information on what they’ve already collected for the
Final Report.

Step 3: Develop a Plan
Using student input, create an Action Plan for completing the report.

Step 4: Complete the Report
Following the Action Plan, complete the report. Please note, the report should be typed
whenever possible. Additional information, pictures, etc. are welcome.

Step 5: Submit the Report
Please send the Scrapbook to:

Carol Timms

EnergyNet

302 West Hill Street, Suite 102
Champaign, IL 61820

Step 6: Celebrate
Celebrate your students’ achievements. Hold an final discussion asking students what they
didn’t like about the program and what they did like. We will ask for your comments as well.
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Final Report Outline

VI.

VII.

VIII.

VIII.

IX.

Information about the Detective Agency

A. What is the name of this Detective Agency

B. What were the goals of the Detective Agency? (These should be posted with
the name of the Detective Agency in the Big Book.)

C. Did you accomplish your goals? If so, how? If not, why not?

FliP the Switch
A. Did you communicate with FLiP?
B. If so, what skills did you learn?

Suspects and Plan of Action

A. What suspects and possible crimes were discovered during the Stakeout?

B. What activities did you choose to Reform Energy Thieves and Reward Good
Citizens?

C. What committees were formed to implement your Plan of Action?

D. Were the committees successful in meeting their goals? If so, how? If not,
why not?

Energy Efficiency at Home

A. What suspects and possible crimes were discovered during your Stakeout at
your home?

B. What activities did you choose to interest your family in energy efficiency?

C. Were you successful in interesting your family in energy efficiency?

Energy Use

A. What changes took place in energy use both at school and at home during
and after your Plan of Action compared to the same time period last year?

B. If you do not know, how can you find out?

Conclusion

A. What did you like best about the Energy Detectives project?

B. Do you have suggestions for improving the project?
C. What do you think you learned from the project?
D What suggestions do you have for future Detectives?

Please submit a typed report to Headquarters along with your Scrapbook
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